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Abstrak: Kebijakan pencegahan pandemi Covid-19 berdampak pada berkurangnya program praktikum yang harus 
dibina bagi mahasiswa. Dalam makalah ini, kami menunjukkan bagaimana video tracker telah efektif dalam 
mencapai praktikum gerakan lurus berubah beraturan dan menentukan gravitasi bulan dengan menggunakan e-
learning, diskusi kelompok, analisis video gerakan jatuh bebas pada percepatan gravitasi bulan. Setelah penerapan 
video tracker, hasil analisis data kuantitatif dan kualitatif menunjukkan bahwa mahasiswa angkatan 2018 
pendidikan fisika Universitas Negeri Surabaya memiliki pengalaman yang signifikan dan berkomentar positif 
terhadap pengalamannya. Siswa menunjukkan bahwa mereka puas dengan lingkungan praktikum dengan 
menggunakan video tracker, dan penerapan video tracker untuk mengetahui percepatan gravitasi bulan untuk 
meningkatkan kemampuan keterampilan mereka dalam melakukan percobaan. Praktikum gerak lurus berubah 
beraturan dan penentuan percepatan gravitasi bulan dengan menggunakan video tracker yang dijelaskan dalam 
artikel ini dapat dijadikan acuan untuk memastikan kualitas program praktikum sains online selama pandemi Covid-
19. Hasil penelitian menunjukkan bahwa lingkungan praktikum berbasis video tracker dapat melatih keterampilan 
laboratorium IPA berupa memprediksi, mengamati, menjelaskan, dan menganalisis data video pada fenomena 
ilmiah. 
 
Kata Kunci :  pandemi COVID-19, praktikum sains, video tracker, percepatan gravitasi bulan  
 
Abstract: The covid-19 pandemic prevention policy has the impact of reducing practicum programs that should be 
trained for students. In this paper, we show how a video tracker has been effective in achieving straight motion 
practicum and determining the moon gravity by using e-learning, group discussion, free fall motion video analysis 
on the moon's gravity acceleration. After the application of the video tracker, the results of quantitative and 
qualitative data analysis showed that the 2018 class students from physics science education of the State University 
of Surabaya had significant experiences and commented positively on their experiences. Students show that they are 
satisfied with the practicum environment by using a video tracker, and the application of a video tracker to 
determine the moon's gravitational acceleration to improve their skill proficiency in conducting an experiment. The 
straight motion practicum and the determination of the moon's gravity acceleration by using the video tracker tool 
described in this paper can be used as a reference to ensure the quality of the online science practicum program 
during the Covid-19 pandemic. The investigation results show that a video tracker-based practicum environment 
can train science laboratory skills in the form of predicting, observing, explaining, and analysing video data on 
scientific phenomena. 
 
Keywords : COVID-19 pandemic, sciences practicum, video tracker, the moon’s gravitational acceleration 
 
INTRODUCTION 

Since there have been signs of the entry of the 
Covid-19 virus, teaching and learning processes in 
primary, secondary and tertiary schools around the 
world have begun to be considered and prepared to 
be implemented online. Taking into account the need 
for learning, various inputs from experts and 
organizations and taking into account the public 
safety, governments from various countries have 
made restrictions related to the implementation of 
learning, especially in the red zone (prone areas of 
Covid-19 infection). In the green zone (areas that are 
considered safe from Covid-19 infection), face-to-
face learning can be carried out but are required to 
implement very strict health protocols. The 
governments of several countries have granted 
practicum-learning permits for several schools or 

colleges. The implementation of practicum learning 
for students is allowed in both the red and green 
zones by obliging the implementation of health 
protocols strict. However, the reality is both schools 
and parents of students are still hesitant to give their 
children's permission to study in school, so that this 
practicum learning cannot be implemented optimally 
during the Covid-19 pandemic [1]. 

This Covid-19 pandemic has dramatically 
disrupted school activities around the world. Social 
distancing requirements have resulted in many 
countries closing physical school buildings or 
remaining open but providing a hybrid model of 
outside classroom teaching and learning. This 
condition raises various challenges for the Initial 
Teacher Education (ITE) program, which is located 
in the context of Higher Education (HE), especially 
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in fulfilling practicum requirements [1]. Because the 
new pathogenic characteristic of Covid-19 is highly 
contagious, implementing health protocols and large-
scale social restrictions (PSBB) is inevitable to 
prevent its rapid spread at the community level [2]. 
As a result, like most professional activities, the daily 
activities of schools / colleges and laboratories are 
suspended in schools, colleges and universities 
around the world for an indefinite period. However, 
radical advances in information technology and 
modern tools allow us to stay connected and do well 
to learn science from home while living at a safe 
distance [3]. 

As educators, we must strive to continue 
presenting a quality-learning atmosphere in the 
classroom and online learning. In an effort to 
improve the quality of learning, suggests that science 
teachers try to expose their students to the real 
process of science as explicitly as possible. Goh, J et 
al. (2011) also paid attention to the importance of 
original data obtained from nature (real data), ".... 
perhaps one of the most significant things you can do 
in your classroom is to give students the opportunity 
to work with real data'. 

Science learning is ideally delivered by 
presenting facts, objects and or scientific phenomena   
to students directly. The problem is that, sometimes 
there are phenomena   that can be observed directly, 
but cannot be easily analyzed by students. For 
example, the phenomena   of two-dimensional 
motion, such as regular straight motion, accelerated 
straight motion, motion of balls, free fall motion, 
motion on inclined planes etc. These phenomena   
can be easily observed in the real world. However, 
when students observe this phenomena, not much 
information can be obtained. In this event, it is 
difficult for students to know how much the initial 
velocity is (vo), how much the acceleration is (a), 
how much the final velocity is (vf), how much the 
velocity at a certain time is (vt). This data is very 
difficult to be obtained from observation if learning 
is carried out only with the help of commonly used 
tools such as ticker timers, stopwatches and so on. 

One of the impacts of the difficulty in 
obtaining meaningful information from a real-world 
phenomena  is the tendency for teachers to present 
the concept directly in front of the class without 
going through investigative activities. Lack of 
investigative activity will cause students to be less 
trained in carrying out scientific investigation 
processes and ultimately not accustomed in 
interpreting real-world phenomena. Therefore, we 
need a breakthrough in how to develop a learning 
model that can facilitate students to investigate real 
phenomena from the real world by utilizing 
information technology to overcome the constraints 
of limited human observation abilities. Teachers need 
to consider utilizing information technology that can 
help students in retrieving data, presenting data and 
more accurately interpreting the results of an 
investigation of scientific phenomena from the real 

world in science learning, especially in the era of the 
Covid-19 pandemic. 

Tracker is a relatively new pedagogical 
approach called ‘video modelling’ [6]. The recent 
version Video Tracker analysis is 5.15. The free 
software of Tracker tool used in this ‘video 
modelling’ can be downloaded from the Open Source 
athttps://www.compadre.org/osp/items/detail.cfm?ID
=7365.  

Ordinary e-learning courses are not enough to 
practice skills about laboratory experiments or 
scientific data analysis [1]. In this regard, video 
trackers add a new dimension to web-based digital 
learning [8]. Video trackers are round-the clock 
available and the replicas are easily accessible. Video 
modelling pedagogy is suitable for active and deep 
learning because the students can be said to be 
predicting by keying certain values, observing by 
comparing the real data with the current proposed 
model, and explaining [9,10] their choice of values 
and making sense of the video analysis data. Even 
with incorrect models proposed, the results from the 
world view and associated multiple representational 
views [11] in various scientific plots can allow the 
facilitation of data driven social discussions among 
students and teachers. This article provides insight 
into studies that test student laboratory skills based 
on a video tracker to support students' science 
practicum experiences in online science learning. 
 
Tracker Video Analysis & Modelling Tools 

One application that can be used to help 
students learn various phenomena of two-
dimensional motion is Tracker Video Analysis. This 
application was developed by Java Open Source 
Physics (OSP) and has the ability to track the motion 
of an object, so that various needed information in 
two-dimensional motion analysis can be obtained. 
Through the activity of recording a real motion 
phenomena by using a video recorder (handy came), 
then the results of the recording are processed in the 
Tracker Video Analysis application, so students can 
get a variety of information such as the position of 
objects (x, y) at each time (t), so that it will provide 
easiness in the motion analysis process. 

Tracker is a software that is capable in 
analyzing and modelling motion and optical 
phenomena, free of charge, and developed by Open 
Source Physics (OSP) by using the Java framework 
[12]. Through the tracker, educators and or students 
can easily analyze real-world problems, especially on 
the topic of motion and optics which are sometimes 
impossible to do without the help of technology. As 
mentioned by Bryan [13] "inexpensive video analysis 
technology makes possible the investigation of 
numerous types of motion with detail and precision 
that would be incredibly difficult, if not impossible, 
without the use of this technology". 

In simple terms, Tracker has the ability to 
track the motion of an object so that various needed 
information in the analysis of a motion event can be 
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obtained. Through the activity of recording a real 
motion phenomena by using a video recorder (handy 
came), the recording results can be processed in the 
Tracker application. In this way, we can interpret the 
various displayed data on the device, making it easy 
for us to carry out an analysis of the motion 
phenomena. Trip [14] in a study found that the use of 
video analysis in learning would change the learning 
practices of teachers in teaching their students. These 
changes occur due to several things, they are: (a) 
focus their analysis, (b) see their teaching from a 
new perspective, (c) feel accountable to change their 
practice, (d) remember to implement changes, and 
(e) see their progress. 
 
Steps of Tracker Usage 

How do I use the tracker? To answer this 
question, the following is the standard steps that must 
be taken in using a tracker to analyze a motion. First, 
Install the Tracker Video Analysis & Modeling Tools 
program, which is an application that can be accessed 
freely. This master program can be downloaded 
through the address 
https://www.compadre.org/osp/items/detail.cfm?ID=
7365. After successful downloading, do the program 
installation process on the computer. This program 
can run on Windows, Mac OS, and Linux operating 
systems. To run this application, the computer must 
be supported by Java 1.6 program or a higher 
version.  

Second, Recording Motion Phenomena, the 
working principle of the tracker is to analyze motion 
phenomena that have been recorded in the form of 
video files. Therefore, the first step that we must take 
is to prepare a motion video to be analyzed. For 
example, if we want to analyze a parabolic motion, 
then throw the ball at a certain elevation angle to 
form a parabolic motion. While the ball is moving, 
record it by using a handy came or smartphone. 
However, to get a video that can be analyzed, there 
are a few things to note: Choose an object with a 
bright colour. In this example, we can use a tennis 
ball that is bright green; select a background that has 
a dark colour.  

In principle, the colour of the moving object 
(ball) should be sufficiently contrast to the 
background colour, place a one-meter ruler on the 
background, and make sure that this line will appear 
during video shooting. This ruler will eventually be 
used as a tool to calibrate the length during the 
“track” process, and then take multiple shots for the 
best results. If recording by using a smartphone, it is 
recommended that you shoot in landscape or portrait 
position. This is done in anticipating so that we get 
the right video orientation for analysis. After the 
recording process, transfer the recorded file to a 
computer that has the tracker installed. Third, open 
the program.  

Open the Tracker program by double clicking 
the Tracker shortcut on the computer desktop. 
Fourth, inserting a video, choose the File> Open 

File menu in the left corner. After that, look for the 
video file about the motion that we saved on the 
previous computer. Fifth, Selecting a Video Frame. 
If the video has been successfully inserted into the 
tracker workspace, the next step is to select the part 
of the video to be analyzed. Usually, not all parts of 
the video are important to be analyzed. Therefore, we 
have to cut the unnecessary parts. The trick is to play 
the video first so that we can find out which part of 
the video is needed to be analyzed. In the lower left 
corner, there is a red number to show the frame 
number. As long as the video is playing, pay 
attention to the numbers in that section, then decide 
on which frame the video will start and at what frame 
the video will end (finish) for analysis purposes. 
After that, click the "Clip Setting" icon (Negative 
Film Image), then write down the numbers on the 
Start Frame and End Frame. Sixth, Long Calibration. 
The next step is to give a long definition 
(Calibration). As mentioned earlier, when doing the 
recording process it is necessary to place a one-meter 
long ruler. The ruler length will now be used to 
define the length for this analysis.  

The trick is, click Calibration Tools> New> 
Calibration stick so that a blue line appears on the 
Tracker workspace. Change the number 100.0 to 
1,000, and then move the ends of the blue line to the 
ends of the one-meter ruler on the video display. In 
this way, we have calibrated the length of the ruler to 
one meter. Seventh, Enter the Coordinate Axes. 
Make a Cartesian coordinates (X, Y axes) in the 
workspace. Click the Coordinate axes icon, then in 
the workspace two purple lines will appear 
intersecting perpendicularly as the coordinates of the 
object's position. Then shift these coordinates by 
placing the origin (0,0) on the object (ball) at the 
Start frame. Once successful, hide the coordinates by 
clicking once again on the Coordinate axes icon. 
Eighth, Creating "Point Mass". Define the mass of 
the object by clicking Create> Point Mass icon so 
that a box that says Point Mass A will appear. In an 
experiment that considers the mass of the object, 
enter the mass value of the object in the box. 
However, in the case of the parabolic motion, the 
mass of the object has no effect at the time of 
analysis, so we can leave the number in the box as 1. 
Ninth, Making the Path of the Object's Movement. 
This step is the culmination of the activity "track" 
moving objects. We can choose two techniques, 
namely manual techniques and automatic techniques.  

The following describes each technique: a) 
Manual technique. Press the "Shift" key on the 
keyboard, then at the same time hover the cursor 
over the surface of the object (ball), then do the left 
click. A moment later the object (ball) will move to 
the next frame, and then do the same thing by 
pressing the "Shift" key and clicking on the object's 
surface (ball). Do this step continuously until you 
reach the last frame. If this step has been carried out, 
the graph and table of time (t) and position (x & y) 
will automatically appear on the right side of the 
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screen. b) Automatic Technique. Click the Point 
Mass A> Auto tracker box, so that the Auto tracker 
box will appear. Press Shift + Ctrl on the keyboard 
then put the cursor on the surface of the object (ball), 
then do the left click so that it will activate the 
"search" button on the auto tracker box. Then click 
the "Search" button so that the object (ball) will 
move automatically. If the ball stops (even though it 
has not arrived at the last frame), then click the 
"accept" button at the bottom of the box until the 
object (ball) moves again. If this step has been 
carried out, the graph and table of time (t) and 
position (x & y) will automatically appear on the 
right side of the screen.  

Tenth, Analyzing Tables / Graphs. If the 
process of creating the path has been successful, then 
on the right side of the Tracker workspace two 
important sections will appear, namely the Position 
and Time Graph, and the Position and Time Table. 
We can change what variable / quantity we want to 
display by clicking on the axis title, then changing it 
with the desired variable. For example, on the letter 
"x" we click, it will display a selection of symbols 
for other variables, such as "y", "vx", "vy", etc. To 
perform further analysis, double click the graphic 
area, it will display the "Data Tool Box". Through 
this box, we can do a lot of graphic analysis for the 
motion that we have recorded. Click the "Measure" 
menu then select "coordinate", "slope" and "area". 
After that, click the "Analyze" menu and select 
"Statistics" and "Curve Fit". 

Based on the various information contained in 
the Data Tool Box, there will be a lot of data and 
graphs that we can analyze. As an example in the 
image above, we have just analyzed the graph of 
position (y) and time (t). On the upper right side, 
there are several statistical data such as maximum, 
minimum, average, and standard deviation values. 
While below it, we can see the position value (y) 
which continues to change according to changes in 
time (t). At the bottom of the graph we are shown the 
equation y = A * t + B with the value A = 2.315E0 
and B = 1.359E-2. What do the numbers mean? If 
you pay attention, it is a linear line equation where y 
refers to the position in the vertical direction (y), A is 
the slope (gradient) of the formed linear line, and B 
shows the initial value of the object's position. The 
slope (gradient) value on the graph refers to the 
change in the position value (y) per time unit (t) or y 
/ t. We know that the position of each unit of time is 
the velocity. Therefore, the value of A in the 
equation provides information on the average 
velocity of objects on the y-axis (Sabar Nurohman, 
2012). 

METHOD 
Before students conduct a practicum on 

determining the moon's gravitational acceleration, 
students had been trained online in the Covid-19 era 
to download and install a video tracker tool, and use 
it to analyse free fall motion videos. They have also 

passed the skill test to analyze free fall motion 
videos. Students who do not pass the exam are not 
included in practicum activities to determine the 
moon's gravitational acceleration. There are 75% (30 
people) of students who are eligible to participate in 
this advanced practicum activity. Next, they were 
asked to download the experimental video of a 
hammer and a feather dropped on the moon surface 
at the same height and time by an Apollo 15 
astronaut in 1971 named David Scott at the following 
link 
https://www.youtube.com/watch?v=Oo8TaPVsn9Y
&feature=youtu.be .  

After that, the students were asked to analyse 
the video to determine the moon's gravitational 
acceleration in 90 minutes. The video analysis result 
files of the students in the trk format and the fitting 
data files were collected via email for both 
quantitative and qualitative assessments. Researchers 
also conducted qualitative surveys and informal 
interviews with students to obtain qualitative data 
about learning by using a video tracker tool, a tracker 
tool in practicing inquiry and thinking like a scientist, 
and the faced obstacles in using the video tracker tool 

RESULTS AND DISCUSSION 

Video analysis of the moon's gravitational 
acceleration determination 

The mathematical equation that represents the 
free fall motion is 
 
      (1) 
 

Where  is the object's height (hammer or 

feather) at time t, 0 is the object's initial height at 

t=0 seconds.  is the determined gravitational 

acceleration (moon) in this experiment, and t is the 
time it takes for the object to travel the height of . 

After using the video Tracker to track the projectile 
trajectory manually or automatically, the data tools 
can be used to analyse the motion and allow the 
determination of numerical values of quantities such 
as the gravitational acceleration of the moon,  of 

the moon. This can be done by comparing the fitting 
coefficient of the parabolic curve as in equation (2) 
with equation (1). 
 
      (2) 
 
  

 
Where A, B, and C are the coefficients of the 

parabolic fitting curve. The values of A, B, and C can 
be seen in Figure 3, where A = -0.8421, B = -0.1074. 
and C = -0.07193. To determine the gravitational 
acceleration value of the moon, , then the 

coefficient of  in equations (1) and (2), so that - 

 = -0.8421  or  = 2 (0.8421) = 1.68 ms-2. 

Figures 1, 2, and 3 below are one of the results 
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presentations of video analysis by students to 
determine the moon’s gravitational acceleration.  
 

 
 

 

Figure 1. Video of David Scott’s early hammer dropping on the initial 1784 frame and for the purposes of the 
astronaut's 1.9 meters high calibration 

 

Figure 2. The parabolic fitting curve of the fall hammer and in this case the obtained coefficient value of A = -
0.8421, B = -0.1074, and C = -0.07193 

Most of the students have good video analysis 
skills. This can be seen from the quantitative and 
qualitative data from the results of laboratory 
activities to analyse the video to determine the 
moon’s gravitational acceleration as shown by Fig. 1 
and Fig. 2. In Fig. 1, most students can already 
predict whether hammer or feather is used for free 
fall objects. Because the hammer object in the video 
is relatively clearer than the feather object, almost all 
students chose hammer as the free fall object on the 
moon. Most of the students have the ability to 
observe the phenomena of free fall objects on the 
moon as shown in the video correctly. The quality of 

the video is not good because the hammer’s colour 
and the background are almost the same, so students 
need carefulness to ascertain which parts of the video 
can be analysed to determine the acceleration of the 
moon. So that Fig. 1 can specify the exact starting 
frame [6], for example 1784 (red colour to the left of 
“Play”). Likewise, on Fig. 2, the final frame can be 
determined, for example 1799. Students also have the 
skills to calibrate the hammer height at any time 
against the moon surface, whether in meters or 
centimetres [6]. The student's calibration ability can 
be assessed from the accuracy of how many meters 
of objects on the moon’s surface are relatively valid 
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for calibration. In the video, there are several objects 
that can be used for calibration purposes, the height 
of the American flag, the height of the human being, 
the height of other used objects by astronauts whose 
images are recorded in the video. Almost all students 
use astronaut height (David Scott) as a calibration. 
They assumed David Scott's height was 1.9 m to 2.0 
m. The ability to determine which hammer parts in 
the video can be traced let the students get a 
representative graphic for the free fall hammer. In 
this case, most of the students chose a part of the 
hammer that contrasts with the background. In 
analysing the derived data from the free fall hammer 
on the moon video (Fig. 3), almost all students can 
make and analyse a graph of hammer height, Y vs t 
(time) and then compare the coefficient of the t2 
parabolic fit curve in equation (2) with equation (1). 
It is from this comparison that the moon's 
gravitational acceleration can be found.  

To provide information about conditions and 
processes during learning in the laboratory by using a 
video tracker tool, the following is a summary of the 
qualitative survey results and informal interviews 
with students. In general, students commented 
positively about fun active learning in online 
practicum activities by using video tracker tools. The 
following is a summary of the comments from most 
students: "The level of my science understanding 
improves, especially free-fall objects, because I can 
observe real-life examples of free fall objects on the 
moon in a fun and interesting way". “I like to 
conduct experiment with this interesting video 
tracker tool. Learned a lot in a fun way”. “I thought it 
was amazing how I could determine the moon's 
gravitational acceleration only by using a video 
tracker tool just as scientists find the moon's 
gravitational acceleration, I also understand better 
how to do so many fun stuffs while doing online lab 
work by using that tool”. “I also quickly adapt in 
using the video tracker tool and easily overcome 
when there are initial difficulties in doing 
practicum”. Video tracker tools like virtual 
laboratories are round-the clock available and an 
easily accessible figured replica of the real-life 
laboratories that can provide practical skills of 
science to the learners [15, 16]. Such track video 
allows the learners to obtain knowledge and 
laboratory skills regarding real life experiments [17, 
18]. 
  More importantly, a video modelling that is 
especially driven by data from video analysis, 
enables students to discover by using evidence and 
incomplete models proposed by themselves, to 
gradually and iteratively improve and find 
themselves a better model for predicting and 
explaining projectile motion. This has resulted in a 
very enjoyable "Eureka" experience for our students 
as they connect abstract concepts and formulas with 
real-world examples thereby deepening learning. 

 

CONCLUSION 
The investigation results show that the 

straight motion practicum and the determination of 
the moons’ gravitational acceleration by using the 
video tracker described in this paper can be used as a 
reference to ensure the quality of the online science 
practicum (physics) program during the Covid-19 
pandemic. The results of the investigation also show 
that a video tracker-based practicum environment 
can practice science laboratory skills in the form of 
predicting, observing, explaining, analysing video 
data on scientific phenomena. The relative ease of 
installing and using the Video Tracker to perform in-
depth learner-cantered video analysis with reference 
to the theoretical physics model of the ideal free fall 
motion is discussed in this article. The inferred 
values  from the video analysis are consistent with 
real data for the acceleration of gravity on the moon 
surface. 
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